WorkForce® 40 Series

Quick Guide

Basic Printing
Maintaining Your Printer
Solving Problems

EPSON
EXCEED YOUR VISION
Introduction

After you have set up your WorkForce™ 40 Series as described on the Start Here sheet, turn here to:
■ Load paper
■ Get the basic steps for printing from your computer
■ Perform routine maintenance
■ Solve simple problems

For additional instructions, see the on-screen Epson Information Center by double-clicking the icon for it on your desktop.

Please follow these guidelines as you read the instructions:

Warning:
Warnings must be followed carefully to avoid bodily injury.

Caution:
Cautions must be observed to avoid damage to your equipment.

Note:
Notes contain important information about your printer.

Tip:
Tips contain hints for better printing.
Loading Paper

You can print on a variety of paper types and sizes. For details, see page 6.

1. Open the paper support and pull up the extensions.

2. Open the output tray, pull out the extensions, and flip up the paper stop.

3. Squeeze the edge guide and slide it left.

Do not raise the paper stop for legal-size paper.
4. Insert paper short edge first (glossy or printable side up), against the right side. Load letterhead or pre-printed paper top edge first.

You can load up to 100 sheets of plain paper, 80 sheets of Epson Bright White Paper or Presentation Paper Matte, or 20 sheets of photo paper. Load other special papers one sheet at a time.

**Note:**
The type of paper you choose affects the way your printout looks. If you are just printing a rough draft, plain paper is fine. However, for the best results, you’ll want to use one of Epson’s special ink jet papers designed for your printer. See the next section for more information.

5. Slide the edge guide against the paper, but not too tightly.

**Note:**
For details on paper and instructions on loading envelopes, see your on-screen *Epson Information Center.*
Using Special Papers

Epson offers a wide array of high quality papers, making it easy to maximize the impact of your presentations, photos, and creative projects.

You can purchase genuine Epson ink and paper at Epson Supplies Central™ at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) or visit Epson's website.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>4 × 6 in.</td>
<td>S041809 S042038</td>
<td>50 100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041141 S041649 S041271</td>
<td>20 50 100</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Borderless 4 × 6 in.</td>
<td>S041808 S041727</td>
<td>40 100</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 in.</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 in.</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 in.)</td>
<td>S042183 S041667</td>
<td>25 50</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Borderless 4 × 6 in.</td>
<td>S042181 S042174</td>
<td>60 100</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 in.</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 in.</td>
<td>S041946</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 in.)</td>
<td>S042182 S042175</td>
<td>25 50</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Borderless 4 × 6 in.</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041331</td>
<td>20</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 in.)</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td>Paper type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Borderless 8 × 10 in.</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041257</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042180</td>
<td>100</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041341</td>
<td>50</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>A4 (8.3 × 11.7 in.)</td>
<td>S041106</td>
<td>10</td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td>Letter (8.5 × 11 in.)</td>
<td>S041153</td>
<td>10</td>
</tr>
</tbody>
</table>
Basic Printing

This section describes the basic steps for printing a document or photo stored on your Windows® or Macintosh® computer. For detailed instructions on printing, see the on-screen Epson Information Center.

Before you start, make sure you've installed your printer software and connected the printer to your computer as described on the Start Here sheet.

Tip:
It's a good idea to check for updates to your WorkForce 40 Series software (see page 24 for instructions).

Printing in Windows

1. Open a document or photo in an application.

2. Open the File menu and select Print. You see a window like this one:

3. Make sure EPSON WorkForce 40 Series is selected, then click the Preferences or Properties button.
   (If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties on the next screen.)
4. On the Main tab, select the basic print settings. Make sure you choose the correct paper Type setting for the paper you are using (see page 14 for details).

Tip:
For quick access to the most common settings, click the Shortcuts tab and select one of the presets. You can create your own presets by clicking the Save Settings button on the Advanced tab. For details, see your on-screen Epson Information Center.

5. To improve the color, contrast, and sharpness of photos, select Fix Photo.

6. To reduce or remove red-eye effects in photos, select Fix Red-Eye.

7. If you want to reduce or enlarge your printout, or print double-sided, click the Page Layout tab and select settings as necessary.

8. For more printing options, click the Advanced tab.

Note:
For more information about print settings, click Help or see your on-screen Epson Information Center.

9. Click OK to save your settings.
10. Click OK or Print to start printing. This window appears and shows the progress of your print job.

![Printer window](image)

**Printing With a Macintosh**

See one of the sections below for your Mac OS® operating system.

**Mac OS X 10.5**

1. Open a document or photo in an application.
2. Open the File menu and select Print.
3. Select EPSON WorkForce 40 as the Printer setting.

![Printer settings](image)

4. Click ▼ to expand the Print window, if necessary.
5. Select the basic page setup options. For borderless photos, choose a Paper Size setting with a Sheet Feeder - Borderless option.

**Note:**
If the setting you want isn’t shown (for example, Scale), check for it in your application before printing.

6. Choose **Print Settings** from the pop-up menu, then select the following settings that appear on the bottom of the screen:

7. Choose any other printing options you may need from the pop-up menu. See the on-screen Epson Information Center for details.

**Tip:**
To reduce or remove red-eye effects in photos, choose Extension Settings from the pop-up menu and select Fix Red-Eye.

8. Click **Print**.
9. To monitor your print job, click the printer icon in the dock. Select your print job, then select an option to cancel, pause, or resume printing, if necessary.

Mac OS X 10.3 to 10.4

1. Open a document or photo in an application.
2. Select Page Setup from the File menu. Select the following settings:

   - Select your printer
   - Select your Paper Size
   - Select your document or image orientation

   For borderless printing, choose a Sheet Feeder - Borderless option in the Paper Size list for your paper size.
3. Click OK to close the Page Setup window.
4. Select Print from the File menu. You see a window like this one:

![Print settings window](image)

Select your printer
Select Print Settings

5. Choose Print Settings from the pop-up menu and select the following settings as necessary:

![Advanced settings window](image)

Select your paper type (see page 14)
Select Color or Black/Grayscale output
Select higher quality or faster printing (if available)
Select Automatic mode

**Note:**
In certain programs, you may need to select Advanced before you can select Print Settings. For more information about printer settings, click the ? button.

6. Click the Advanced button to change additional settings.

**Note:**
For more information on advanced settings, click ?.

7. Choose any other printing options you may need from the pop-up menu. See your on-screen Epson Information Center for details.

8. Click Print.
9. To monitor the progress of your print job, click the printer icon in the dock (or click the Print Center icon and double-click WorkForce 40 on the next screen).

Selecting the Correct Paper Type

Select the correct Type (see page 9) or Media Type (see page 11 or page 13) setting in your printer software. This tells the printer what kind of paper you're using, so the ink coverage can be adjusted accordingly.

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td></td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>

14 Basic Printing
Maintaining Your Printer

Follow the instructions in this chapter for checking and cleaning the print head nozzles and replacing ink cartridges. To align the print head, if necessary, see your on-screen Epson Information Center.

Caution:
To keep your printer looking like new, don’t place anything on top of the cover or use it as a writing surface. If you need to clean the cover, use only a soft, non-abrasive microfiber-type cloth.

Checking the Print Head Nozzles

If your printouts are faint or have gaps in them, some of the nozzles in the print head may be clogged or ink may be running low in one or more of the ink cartridges. Follow the steps below to check the print head nozzles.

1. Load letter-size paper in the sheet feeder.
2. Turn off the printer.
3. Hold down the button as you press the power button to turn the printer back on. Hold down both buttons until the power light begins to flash, then release the buttons.
4. Check the nozzle check pattern that prints to see if there are gaps in the lines.

   ![Nozzles are clean](image1.png) ![Nozzles need cleaning](image2.png)

5. If there are no gaps, the print head is clean. If there are gaps or the pattern is faint, clean the print head as described in the next section.

---

**Cleaning the Print Head**

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head. Print head cleaning uses ink, so clean it only if necessary.

**Note:**
Print head cleaning uses ink, so clean it only if quality declines and the nozzle check indicates the print head needs to be cleaned. You cannot clean the print head if an ink cartridge is expended, and you may not be able to clean it when a cartridge is low. You must replace the cartridge first (see page 19).

1. Make sure the printer is on and the &ink light is off.
2. Hold down the &ink button for at least 3 seconds to start the cleaning cycle, which lasts around 1 minute.

   **Caution:**
Never turn off the printer during head cleaning or you may damage it.

3. When the &power light stops flashing, run a nozzle check (as described on page 15) to verify that the print head is clean.
4. If there are still gaps or lines, or the test patterns are faint, run another cleaning cycle and check the nozzles again.

**Note:**
If you don’t see any improvement after cleaning the print head three times, turn off the printer and wait at least six hours to let any dried ink soften. Then try cleaning the print head again. If quality does not improve, one of the ink cartridges may need to be replaced. If that doesn’t help, contact Epson as described on page 28.

If you do not use your printer often, it is a good idea to print a few pages at least once a month to maintain good print quality.
Checking the Ink Cartridge Status

When the ink light starts flashing, one or more cartridges are low on ink. You can continue printing until a cartridge needs replacement. When the ink light stays on, you need to replace the cartridge(s).

Caution:
You cannot print when an ink cartridge is expended even if the other cartridges are not expended. Leave the expended cartridge(s) installed until you have obtained a replacement, or the ink remaining in the print head nozzles may dry out.

A window may also appear on your computer screen when you try to print when ink is low. This window can optionally display ink offers and other updates retrieved from an Epson website. On a computer that is connected to the Internet, you may see a screen asking if you want to receive these Epson offers the first time you try to print when ink is low. Click Accept or Decline.

Note:
To disable checking for ink offers or updates from Epson, see the instructions in your on-screen Epson Information Center.

Tip:
If a cartridge is more than six months old, print quality may decline. If necessary, try cleaning the print head (see page 16). If printouts still do not look their best, you may need to replace the cartridge.
Purchasing Ink Cartridges

You can purchase genuine Epson ink and paper at Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766). Use the following list when you order or purchase new ink cartridges:

<table>
<thead>
<tr>
<th>Color</th>
<th>Standard-capacity</th>
<th>High-capacity</th>
<th>Extra High-capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>69</td>
<td>68</td>
<td>97</td>
</tr>
<tr>
<td>Cyan</td>
<td>69</td>
<td>68</td>
<td>—</td>
</tr>
<tr>
<td>Magenta</td>
<td>69</td>
<td>68</td>
<td>—</td>
</tr>
<tr>
<td>Yellow</td>
<td>69</td>
<td>68</td>
<td>—</td>
</tr>
</tbody>
</table>

Note:
We recommend that you use genuine Epson cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a small amount of ink remains in the cartridge after the “replace cartridge” indicator comes on. Your printer ships with full cartridges and part of the ink from the first cartridges is used for priming the printer.

For best printing results, use up a cartridge within six months of opening the package.

Store ink cartridges in a cool, dark place. If they have been exposed to cold temperatures, let them warm up to room temperature for at least 3 hours before using them.
Replacing Ink Cartridges

Make sure you have a new ink cartridge before you begin. You must install new cartridges immediately after removing the old ones.

Caution:
Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability.

1. Turn on the printer.
   - If a cartridge is expended, the Δ ink light on the control panel stays on. You must replace the cartridge to be able to print.
   - If the Δ ink light is flashing, a cartridge is low on ink; replacement is recommended.

   Note:
   You can also replace an ink cartridge before the Δ ink light is on or flashing by following the steps below.

2. Open the printer cover.

3. Press the Δ ink button.
■ If a cartridge is low or expended, the print head moves to the \( \mathcal{B} \) position to indicate which cartridge should be replaced. Press the ink button again to see if more cartridges are low or expended. If not, the print head moves to the replacement position on the right.

■ If no cartridges are low or expended, the print head moves to the replacement position on the right.
4. Open the cartridge cover.

5. Squeeze the tab on the cartridge and lift it straight up to remove it. Dispose of it carefully. Do not take the used cartridge apart or try to refill it.

Warning:
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. Keep ink cartridges out of the reach of children.
6. Before opening the new cartridge package, shake it four or five times. (Do not shake a cartridge after opening the package; ink may leak.)

7. Remove the cartridge from the package.
   **Caution:**
   Do not touch the green chip on the front of the cartridge. This can damage the ink cartridge.

8. Remove the yellow tape from the bottom.
   **Caution:**
   Do not remove any other labels or seals, or ink may leak.

9. Insert the new ink cartridge into the holder and push it down until it clicks into place.
10. Once you replace all the necessary cartridges, close the cartridge cover and push it down until it clicks into place.

11. Close the printer cover.

12. Press the ink button to begin charging the ink. This takes about 2 1/2 minutes.

When the power light stops flashing and remains on, ink charging is finished.

Caution:
Never turn off the printer while ink is charging or you'll waste ink. If the ink light flashes, press the ink button and press down all the cartridges securely.

Note:
If you remove a low or expended ink cartridge, you cannot reinstall and use the cartridge.
Solving Problems

If you have a problem with your printer, check the lights on the control panel to diagnose the cause.

You can also check “Problems and Solutions” on page 26 for basic troubleshooting suggestions, or double-click the Epson Information Center icon on your computer desktop for more detailed help.

Checking for Software Updates

Periodically, it’s a good idea to check Epson’s support website for free updates to your WorkForce 40 Series software. Open your on-screen Epson Information Center and select Download the Latest Software or visit Epson’s support website at epson.com/support (U.S.) or epson.ca (Canada).

With Windows, you can select Driver Update on the Maintenance tab in the printer settings window. You can also click ☰ or Start, select All Programs or Programs, select EPSON, select EPSON WorkForce 40 Series, and click Driver Update.

Checking the Status Lights

Network status lights

Printing status lights
Check the table below for explanations of the printing status lights. For information about the network status lights, see the Network Installation Guide or the on-screen Epson Information Center.

<table>
<thead>
<tr>
<th>Light status</th>
<th>Problem and solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Status light on] (no other lights are on)</td>
<td>The printer is turned on.</td>
</tr>
<tr>
<td>![Status light on] ![Status light flashing slowly] (no other lights are on)</td>
<td>The printer is in sleep mode. Press any button except the power button to wake it up.</td>
</tr>
<tr>
<td>![Status light on] ![Status light flashing fast] ![Status light flashing fast] ![Status light on]</td>
<td>The printer cover is open. Close the printer cover.</td>
</tr>
<tr>
<td>![Status light on] ![Status light on]</td>
<td>Paper is out or multiple pages have fed. Load or reload paper in the sheet feeder or press the button to eject excess sheets.</td>
</tr>
<tr>
<td>![Status light on] ![Status light flashing slowly]</td>
<td>Paper is jammed. Carefully remove the jammed paper.</td>
</tr>
<tr>
<td>![Status light on] ![Status light flashing slowly]</td>
<td>One or more cartridges have low ink. You can continue printing until a cartridge needs replacement. Check the cartridge status to determine which cartridges are affected.</td>
</tr>
<tr>
<td>![Status light on] ![Status light off]</td>
<td>An ink cartridge is expended, incorrectly installed, or cannot be used with the printer. If an ink cartridge is likely to be expended or is not compatible, you must replace the cartridge to be able to print. If you just replaced a cartridge and the light is still on, the cartridge is not installed correctly. Press the button to move the cartridges to the replacement position. Open the ink cartridge cover, press down on all the installed cartridges, and close the ink cartridge cover. Then press the button to continue.</td>
</tr>
<tr>
<td>![Status light on] ![Status light flashing slowly] ![Status light flashing slowly] ![Status light off]</td>
<td>Parts inside the printer are at the end of their service life. Contact Epson for help (see page 28).</td>
</tr>
<tr>
<td>![Status light on] ![Status light flashing fast] ![Status light flashing fast] ![Status light off]</td>
<td>There is a problem with the printer. Turn it off, wait a few moments, and turn it back on again. If the error is not resolved, contact Epson for help (see page 28).</td>
</tr>
</tbody>
</table>
Problems and Solutions

Check the solutions below if you're having trouble using your printer.

Printing Problems

■ Make sure the WorkForce 40 Series is selected as the default printer in your application program.

■ For USB printing, make sure the USB cable is connected securely at both ends. For network printing, see the Network Installation Guide.

■ Make sure the printer cover is closed.

■ Make sure your paper is loaded short edge first and is positioned against the right side with the edge guide against its left side. Don't load paper above the arrow mark inside the left edge guide.

■ Make sure the paper size settings are correct for the paper you loaded.

Paper Feeding Problems

■ If paper doesn't feed, remove it from the sheet feeder and fan the stack. Reload it against the right side, then press in the tab on the left edge guide and slide it against the paper. Make sure the paper is not above the arrow mark inside the left edge guide.

■ Load only up to the recommended number of sheets. If you're printing on both sides of the paper, try loading fewer sheets.

■ If multiple pages feed at once, remove the paper from the sheet feeder, fan the edges to separate the sheets, then reload it.

■ Do not load paper with holes punched in it.

■ If paper is jammed, follow these steps:
  1. Gently pull out jammed paper from the output tray or sheet feeder.
  2. If paper is stuck inside, turn off the printer.
  3. Open the printer cover and remove the jammed paper, including any torn pieces. Check for any paper under the far-left side of the cover.
**Print Quality Problems**

If you have any problems with the print quality, try these solutions:

- Load the paper printable side up (usually the whiter, brighter, or glossy side).
- Make sure your paper isn’t damp or curled.
- Use a support sheet with special paper or load your paper one sheet at a time. Remove sheets from the output tray so not too many collect at a time.
- Make sure the output tray is fully extended.
- Make sure the type of paper you loaded matches the paper size and paper type settings in your printer software (see page 14).
- For the best print quality, use Epson special paper (see page 6) and genuine Epson ink cartridges (see page 18).
- Select a higher Quality Option or Print Quality and turn off High Speed mode in the printer software.
- If you notice light or dark bands across your printouts or they are too faint, you may need to clean the print head (see page 16). This unclogs the nozzles so they can deliver ink properly. Run a nozzle check (see page 15) to see if the print head needs cleaning.
- If you notice jagged vertical lines, you may need to align the print head. See your Epson Information Center for instructions.
- The ink cartridges may be low on ink. Check your cartridge status (see page 17) and replace cartridges, if necessary (see page 19).
- If you are using double-sided paper and printing heavily saturated or dark images on the front side of the paper, you may notice that smudges or marks appear on the front when you print the second side. If one side of the paper will contain a lighter image or text, print that side first to eliminate marks or smudging.
Where To Get Help

Epson Technical Support

Internet Support
Visit Epson's support website at epson.com/support and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

- Product name (WorkForce 40 Series)
- Product serial number (located on the label in back)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer configuration
- Description of the problem

Then call:
- U.S.: (562) 276-7202, 6 AM to 6 PM, Pacific Time, Monday through Friday.
- Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Other Software Technical Support

ArcSoft Print Creations™
www.arcssoft.com/support
Important Safety Instructions

Before using your WorkForce 40 Series, read and follow these safety instructions:

■ Be sure to follow all warnings and instructions marked on the printer.
■ Use only the type of power source indicated on the printer label.
■ Use only the power cord that comes with the printer. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
■ Place the printer near a wall outlet where the plug can be easily unplugged.
■ If you won’t be using the printer for a long period, unplug the power cord from the electrical outlet.
■ Always turn off the printer using the \( \text{P} \) power button, and wait until the \( \text{P} \) power light stops flashing before unplugging the printer or cutting off power to the electrical outlet.
■ Avoid plugging the printer into an outlet on the same circuit as a photocopier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
■ Do not let the power cord become damaged or frayed.
■ If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
■ Leave enough room around the printer for sufficient ventilation. Do not block or cover openings in the case or insert objects through the slots.
■ Do not place or store the printer near a radiator or heating vent, in a dusty or moist environment, in direct sunlight, or outdoors.
■ Keep the printer away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.
■ Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.
■ Place the printer on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.

■ Do not spill liquid on the printer or use it with wet hands.

■ Except as specifically explained in your documentation, do not disassemble, modify, or attempt to service the printer yourself.

■ Unplug the printer and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.

■ When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down; otherwise ink may leak from the cartridges.

**Ink Cartridge Safety**

■ Keep ink cartridges out of the reach of children and do not drink the ink.

■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.

■ Do not put your hand inside the printer or touch any cartridges during printing.

■ Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the printer from printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area. Store cartridges with their labels facing upward.
FCC Compliance Statement

For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
This Class B digital apparatus complies with Canadian ICES-003.

*Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.*
Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Ink jet printer
Model: B422A
Epson America, Inc., Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser that the Epson printer covered by this limited warranty statement, if purchased and operated only in the United States or Canada, will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the warranty period, please call the Epson ConnectionSM at (562) 276-7202 (U.S.) or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If Epson authorizes repair instead of exchange, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be repaired and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. Using this product for continuous production or similar high duty purposes is not considered normal use; damage, maintenance or service from such use will not be covered under this warranty. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction.
with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR DAMAGES OF ANY KIND IN EXCESS OF THE ORIGINAL RETAIL PURCHASE PRICE OF THE PRODUCT.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at:

To find the Epson Customer Care Center nearest you, visit:
http://www.epson.com/support.

You can also write to:
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Trademarks

Epson is a registered trademark, Epson Exceed Your Vision is a registered logomark, and Supplies Central is a service mark of Seiko Epson Corporation.

WorkForce is a registered trademark and Epson Connection is a service mark of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

This information is subject to change without notice.

© 2009 Epson America, Inc. 2/09